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About InVesalius

InVesalius is public health software that performs analysis and segmenta-
tion of Virtual anatomical models, enabling the creation of physical models
with the aid of rapid prototyping (3D printing). From two-dimensional (2D)
images obtained through Computed Tomography (CT) or Magnetic Reso-
nance Imaging (MRI), the program allows users to create three-dimensional
(3D) anatomical representations of patients for further medical use.

InVesalius is named in honour of the Belgian doctor Andreas Vesalius
(1514-1564), widely considered the father of modern anatomy. InVesalius
software is developed by CTI (Center for Information Technology Center
Renato Archer), a unit of the Brazilian Ministry of Science and Technology
(MCT), since 2001. Initially, only the installation program was distributed
as freeware. In November 2007 InVesalius was made fully available as free
software and open source via the Public Software Portal, allowing for com-
munities of users and developers to connect. InVesalius is, in short, a simple
yet robust, free cross-platform tool that is easy to use.

The use of visualization technologies and three-dimensional analysis of
medical images, when combined with rapid prototyping (3D printing), assists
the surgeon in diagnosing pathologies and a detailed surgical planning and
simulation of complex process in advance, which may involve, for example,
a high degree of facial deformity or integration of prosthetics.

InVesalius has demonstrated great versatility and has applications in dif-
ferent areas, including medicine, dentistry, veterinary medicine, archeology
and engineering.

Download options:

• https://www.cti.gov.br/invesalius

• http://invesalius.github.io

• www.softwarepublico.gov.br

https://www.cti.gov.br/invesalius
http://invesalius.github.io
http://www.softwarepublico.gov.br
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Chapter 1

Introduction

This manual aims to guide end users in the application of InVesalius tools
and also presents some concepts to facilitate the use of the software.

InVesalius is software that is designed to assist health professionals on
diagnosis and surgical planning. It should be noted, however, that all soft-
ware in the diagnostic context is fully supplementary, and each and every act
committed is the responsibility of health professionals.

In addition to medicine, InVesalius can be utilized in other areas such as
archeology, medicine, dentistry, veterinary, or even in industrial applications.
As a basic requirement, the images to be analyzed are in DICOM (Digital
Imaging Communications in Medicine). To date, InVesalius reconstructs im-
ages stemmed from CT scanners and MRI machines. To operate the software,
basic computer literacy is essential. Understanding medical images can help
to form a better understanding of the operations.

1.1 Important Concepts

Detailed in this section are a list of concepts essential to better understand
and operate the software.
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1.1.1 DICOM (Digital Image Communications in Medicine)

DICOM is a standard the transmission, storage and treatment of medical
images. The standard encompasses various origins of medical images, such
as images emanating from computed tomography (CT) equipment, magnetic
resonance, ultrasound, and electrocardiogram, among others.

A DICOM image consists of two main components, namely, an array
containing the pixels of the image and a set of meta-information. This in-
formation includes, but is not limited to, patient name, mode image and the
image position in relation to the space (in the case of CT and MRI).

1.1.2 Computed Tomography - Medical

Computed tomography indicates the radiodensity of tissues, i.e., the average
X-ray absorption by the tissues. The radiodensity reading is translated into
an image gray levels, called the Hounsfield scale, named Godfrey Newbold
Hounsfield, one of the creators of the first CT scan.

Figure 1.1: Medical CT scanner - www.toshibamedical.com.br

Most modern CT scanning appliances are equipped with a radiation emit-
ter and a sensor bank (with channels ranging from 2 to 256), which circle
the patient while the stretcher is moved, forming a spiral. This generates a
large number of images simultaneously, with little emission of X-rays.
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Hounsfield Scale

As mentioned in the previous section, the CT images are generated in gray
levels, expressed in Hounsfield (HU), wherein lighter shades represent denser
matters, and the darker, less dense matter such as skin and brain tissues.

Table 1.1 presents some materials and their respective values in Hounsfield
Units (HU).

Table 1.1: Escala de Hounsfield

Material HU
Air -1000 or less
Fat -120
Water 0
Muscle 40
Contrast 130
Bone 400 or more

1.1.3 Computed Tomography - Dental (CBCT)

The dental CT commonly works with less radiation emission compared to
medical CT, and therefore makes it possible to view more details of delicate
regions such as alveolar cortical.

Figure 1.2: Dental tomography - www.kavo.com.br
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Image acquisition is performed with the patient positioned vertically (as
opposed to medical tomography in which the patient is horizontal). A trans-
mitter X-ray surround the patient’s skull, forming an arc of 180◦ or 360◦.
The images generated are compiled as a volume of the patient’s skull. This
volume is then "sliced" by the software into individual layers, being able to
generate images with different spacing or fields of view, such as a panoramic
view of the region of interest.

The images acquired by dental scanners often require more post pro-
cessing when it is necessary to separate (segmental) certain structures using
other software such as InVesalius. This is because, typically, these images
have more gray levels than, which makes use of segmentation patterns (pre-
set) less. Another very common feature in the images of provincial dental
CT scanners is the high presence of speckle noise and other forms of noise
typically caused by the presence of amalgam prosthetics.

1.1.4 Magnetic Resonance Imaging - MRI

MRI is an examination performed without the use of ionizing radiation. In-
stead, it use a strong magnetic field to align the atoms of any element present
in our body, most commonly hydrogen. After alignment, radio waves are
triggered to excite atoms. The sensors measure the time that the hydrogen
atoms take to realign. This makes it possible to distinguish between different
tissues, as different types possess different quantities of hydrogen atoms.

To avoid interference and improve the quality of the radiofrequency sig-
nal, the patient is placed inside a narrow tube encompassed by the coil and
scanning unit.

1.1.5 Neuronavigation

Neuronavigation is a technique that allows tracking and localization of surgi-
cal instruments relative to neuronal structures through computer visualiza-
tion. In addition, neuronavigation systems a fundamental tool to aid surgi-
cal plan and to increase the accuracy of experiments in neuroscience, such
as transcranial magnetic stimulation (TMS), electroencephalography (EEG),
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Figure 1.3: Magnetic resonance imaging equipment - www.gehealthcare.com

Figure 1.4: Coil - www.healthcare.philips.com

magnetoencephalography (MEG) and near-infrared spectroscopy (NIRS). De-
spite the vast field of applications, the use of neuronavigation in research
centers is limited by its high cost. InVesalius Navigator offers users a low-
cost, open-source alternative to commercial neuronavigation systems. In this
sense, it is possible to use specific tools for neuronavigation and still have
the possibility of developing features on demand. The software for neuron-
avigation is distributed in an executable version compatible with Windows
7, 8 and 10 operating system. The chapter 16 goes into details of all features
of neuronavigation in InVesalius.
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1.2 Resources needed

InVesalius is designed to run on personal computers, such as desktops and
notebooks. Currently, it is compatible with the following operating systems:

• Microsoft Windows (Windows 7, 8, 10)

• GNU/Linux (Ubuntu, Mandriva, Fedora)

• Apple Mac OS X

The performance of InVesalius depends mainly on the amount of recon-
structed slices (images offered by the software), the amount of random access
memory (RAM) available, the processor clock rate & frequency, and operat-
ing system architecture (32-bit or 64-bit).

It is important to note that, as a general rule, the greater the amount
of RAM available on the system, the greater the number of slices that can
be opened simultaneously. For example, with 1 GB of available memory, it
can open about 300 slices with a resolution of 512x512 pixels. With 4 GB
of memory, around 1000 images can be opened simultaneously at the same
resolution.

1.2.1 Minimum settings

• 32-bit Operating System

• Intel Pentium 4 or equivalent 1.5 GHz

• 1 GB of RAM

• 10 GB available hard disk space

• Graphics card with 64 MB memory

• Video resolution of 1024x768 pixels
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1.2.2 Recommended settings

• 64-bit Operating System

• Intel Core 2 Duo processor or equivalent 2.5 GHz

• 8 GB of RAM

• 20 GB available hard disk space

• NVidia or ATI graphics card with 128 MB of memory

• Video resolution of 1920x1080 pixels
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Chapter 2

Installation

2.1 MS-Windows

To install InVesalius on MS-Windows, simply run the installer program.
When a window asking you to confirm the file execution appears, click Yes.
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A new window will ask you to select the language of the installer. Select
the language and click OK.

The Setup installer will appear. Click Next.

15



Select I accept the agreement and click on Next button.

Select the preferred destination for the InVesalius program files, then click
Next.
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Click on Next button.

Select Create a desktop shortchut and click on Next.
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Click on Install button.

While the software is being installed, a progress window will appear.

18



To run InVesalius after installation, check Lauch InVesalius 3.1 and
click on Finish button.

When being run for the first time, a window will appear to select the
InVesalius language. Select the desired language and click OK.
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While InVesalius is loading, the opening window shown below will be
displayed.

The main program window will then open, as shown below.

2.2 Mac Os X

To start the installation on Mac OS X, double-click the installer with the left
mouse button to begin installation.

Hold down the left button on the InVesalius software icon and drag it to
the Applications folder. Both are contained in the installer.
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The software is already installed, just access through the menu.
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Chapter 3

Image import

InVesalius imports files in DICOM format, including compressed files (lossless
JPEG), Analyze (Mayo Clinic c©), NIfTI, PAR/REC, BMP, TIFF, JPEG and
PNG formats.

3.1 DICOM

Under the File menu, click on Import DICOM or use the shortcut Ctrl+I.
Additionally, DICOM files can be imported by clicking on the icon shown in
Figure 3.1.

Figure 3.1: Shortcut to DICOM import

Select the directory containing the DICOM files, as in Figure 3.2. In-
Vesalius will search for files also in subdirectories of the chosen directory, if
they exist.
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Once the directory is selected, click OK.

Figure 3.2: Folder Selection

While InVesalius search for DICOM files in the directory, the loading
progress of the scanned files is displayed, as shown in the Figure 3.3.

Figure 3.3: Loading file status
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If DICOM files are found, a window open (shown Figure 3.4) will open
to select the patient and respective series to be opened. It is also possible to
skip images for reconstruction.

Figure 3.4: Import window
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To import a series with all images present, click "+" on the patient’s
name to expand the corresponding series. Double-click on the description of
the series. See Figure 3.5.

Figure 3.5: Series selection

In some cases, when there is no computer with memory and/or satis-
factory processing to work with large numbers of images in a series, it is
recommended to skip some of them. To do this, click once with the left
mouse button over the description of the series (Figure 3.5) and select how
many images will be skipped (Figure 3.6), then click Import.

Figure 3.6: Skip imagens option

If there is an insufficient amount of available memory at the time of load-
ing the images it is recommended that the resolution of the slices be reduced
to work with volumetric and surface visualization, as shown in Figure 3.7.
The slices will be resized according to the percentage relative to the original
resolution. For example, if each slice of the exam the dimension of 512 x 512
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pixels and the "Percentage of original resolution" is suggested to be 60 %,
each resulting image will be 307 x 307 pixels. To open with the original pixel
resolution, set the percentage to 100.

Figure 3.7: Image size reduction

If the image was obtained with the gantry tilted it will be necessary to
correct to avoid distortion of any reconstruction. InVesalius allows the user
to do this easily. When importing an image with the gantry tilted a dialog
will appear, showing the gantry tilt angle. (Figure 3.8). It is possible to
change this value, but it is not recommended. Click on the Ok to do the
correction. If you click on the cancel button the correction will not be done.

Figure 3.8: Gantry tilt correction

After the above procedure, a window will be displayed (Figure 3.9) with
reconstruction (when images are stacked and interpolated).

Figure 3.9: Reconstruction progress
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3.2 Analyze

To import Analyze files, under the File menu, click Import other files,
then click in the Analyze option as show the Figure 3.10.

Figure 3.10: Menu for importing images in analyze format.

Select the Analyze file format (.hdr) and click on Open (Figure 3.11).

Figure 3.11: Import analyze file format

3.3 NIfTI

To import NIfTI files, under the File menu, click Import other files and
then click NIfTI as shown in Figure 3.12.

Select the NIfTI file format, (either nii.gz or .nii) then click Open (Fig-
ure 3.13). If the file is in another format as .hdr, select all files(*.*) option.
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Figure 3.12: Menu to import images in NIfTI format

Figure 3.13: Importing images in NIfTI format.

3.4 PAR/REC

To import PAR/REC file, under the File menu, click Import other files,
and then click on PAR/REC as shown in Figure 3.14.

Figure 3.14: Menu for importing PAR/REC images

Select PAR/REC file type, with the file extension .par and click Open
(Figure 3.15). If the file has no extension, select all files(*.*) option.
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Figure 3.15: PAR/REC import

3.5 TIFF, JPG, BMP, JPEG or PNG (micro-

CT)

TIFF, JPG, BMP, JPEG or PNG file format for microtomography equipment
(micro-CT or µCT) or others. InVesalius imports files in these formats if
pixels present are represented in grayscale.

To import, click on menu File, Import other files... and then click
on TIFF, JPG, BMP, JPEG ou PNG (µCT) option as shown the
figure 3.16.

Figure 3.16: Import images in BMP and others formats

Select the directory that contains the files, as shown the Figure 3.17.
InVesalius will search for files also in subdirectories of the chosen directory,
if they exist.

Click on OK.
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Figure 3.17: Folder selection

While InVesalius is looking for TIFF, JPG, BMP, JPEG, or PNG files
in the directory, the upload progress of the scanned files is displayed, as
illustrated in Figure 3.18.

Figure 3.18: Checking and loading files status.

If files in the desired formats are located, a window will open (shown in
Figure 3.19) to display the files eligible for reconstruction. Images can also
be skipped to remove files from the rebuild list. The files are sorted according
to file names. It is recommended that the files are numbered according to
the desired rebuild order.

To delete files that are not of interest, select a file by clicking the left
mouse button and then pressing the delete key. You can also choose a range
of files to delete by clicking the left mouse button on a file, holding down
the shift key, clicking again with the mouse button in the last file of the
track and finally pressing the delete button.
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Figure 3.19: Window to import BMP files.

Similar to when importing DICOM files, you can skip BMP images for
re-building. In some cases, particularly where a computer with satisfactory
memory and/or processing is unavailable, it may be advisable to skip some of
them to retain adequate program functionality. To do this, select how many
images to skip (Figure 3.20), then click Import.

Figure 3.20: Importation window

To reconstruct files of this type, a project name must be defined to indi-
cate the orientation of the images (axial, coronal or sagittal), voxel spacing
(X, Y and Z) in mm as shown in the Figure 3.21. The voxel spacing in X
is the pixel width of each image, Y the pixel length, and Z represents the
distance of each slice (voxel height).

If the image set consists of microtomography images, more specifically
GE and Brucker equipment, it is possible that InVesalius will read the text
file with the acquisition parameters that normally stay in the same folder
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as the images and automatically insert the spacing. This verification can
be done when the values of X, Y and Z are different from "1.00000000",
otherwise it is necessary to enter the values of the respective spacing.

Correct spacing is crucial for correctly importing objects in In-
Vesalius. Incorrect spacing will provide incorrect measurements.

Once all parameters have been input, click OK.

Figure 3.21: Import Screen

If insufficient memory is available when loading images, it is recommended
to reduce the resolution of the slices to work with volumetric and surface visu-
alization, as shown in Figure 3.22 window.The slices will be resized according
to the percentage relative to the original resolution. For example, if each slice
of the exam contains the dimension of 512x512 pixels and the "Percentage
of the original resolution" is suggested at 60, each resulting image will have
307x307 pixels. If you want to open with the original resolution set the
percentage to 100.

Figure 3.22: Image resize

After the previous steps, wait a moment for the program to complete the
multiplanar reconstruction as shown in Figure 3.23.
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Figure 3.23: Multiplanar reconstruction in progress.
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Chapter 4

Image adjustment

InVesalius cannot guarantee the correct image order; images may contain
incorrect information, or do not follow the DICOM standard. Therefore, it
is recommended to check if a lesion or an anatomical mark is on the correct
side. If not, it is possible to use the flip image or swap axes tools. For image
alignment, the rotation image tool can be used.

It is possible to mirror the image. To do so, select the Tools menu, click
Image, then Flip and click on one of the following options (Figure 4.1):

• Right - Left

• Anterior - Posterior

• Top - Botton

Figure 4.1: Menu to activate flip image tool.

Figure 4.2 shows a comparison between the input image and the flipped
image. All other orientations are also modified when the image is flipped.

34



(a) Input image (b) Flipped image

Figure 4.2: Example of a right-left flipped image.

4.1 Swap axes

The swap axes tool changes the image orientation, in the case that the im-
age has been wrongly imported. To perform this, select the Tools menu,
click Image, then Swap Axes and click on one of the following options
(Figure 4.3):

• From Right-Left to Anterior-Posterior

• From Right-Left to Top-Bottom

• From Anterior-Posterior to Top-Bottom

The Figures 4.4 and 4.5, shows an example of an image with inverted
axes.

Figure 4.3: Menu to activate swap image tool.
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Figure 4.4: Images before swap axes - from Anterior-Posterior to Top-
Bottom.

Figure 4.5: Images after swap axes - from Anterior-Posterior to Top-Bottom.

4.2 Reorient image (Rotate)

If it is necessary to align the image with a certain point of reference, e.g.
anatomical marker, use the reorient image tool. To open this tool select the
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Tools menu, click Image, then Reorient Image (Figure 4.6).

Figure 4.6: Menu to activate reorient image tool.

When this tool is activated a window is opened (Figure 4.7) showing
orientation and by how many degrees the image was rotated.

Figure 4.7: Window that shows the reorientation image parameters.

To start reorienting the image, define the interpolation method that will
applied after rotation, by default is tricubic interpolation. The interpolation
options are:

• Nearest Neighbour

• Trilinear

• Tricubic

• Lanczos

Then, select the rotation point by keeping the left mouse button pressed
between the two lines intersecting (Figure 4.8) at one orientation, e.g. axial,
coronal or sagittal, and drag to the desired point.

To rotate the image it is necessary to keep the left mouse button pressed
and drag until the reference point or anatomical marker stays aligned with
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Figure 4.8: Defining the axis of rotation of the image.

one of the lines (Figure 4.9). After the image is in the desired position, click
Apply in the parameter window (Figure 4.7). This may take a few mo-
ments depending on the image size. Figure 4.10 shows an image successfully
reoriented.

Figure 4.9: Rotated image.
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Figure 4.10: Rotated image after reorientation is done.
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Chapter 5

Image Manipulation (2D)

5.1 Multiplanar Reconstruction

When images are imported, InVesalius automatically shows its multiplanar
reconstruction in the Axial, Sagittal and Coronal orientations, as well as a
window for 3D manipulation, as seen in Figure 5.1.

Figure 5.1: Multiplanar Reconstruction
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In addition to creating a multiplanar reconstruction, InVesalius segments
an image, highlighting for example soft tissue bones. The highlight is rep-
resented by the application of colors on a segmented structure so that the
colors form a mask over an image highlighting the structure (Figure 5.1).This
is discussed in more detail in the following chapters.

To hide the mask, use the data manager, located in the lower left corner
of the screen. Select the Masks tab and click once using the left mouse
button over the eye icon next to "Mask 1", as shown in Figure 5.2.

Figure 5.2: Mask manager

The eye icon disappears, and the colors of the segmentation mask are
hidden (Figure 5.3).

Figure 5.3: Multiplanar reconstruction without segmentation mask
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5.1.1 Axial orientation

The axial orientation consists of cuts made transversally to the region of
interest, i.e. parallel cuts to the axial plane of the human body. In Figure 5.4,
an axial image of the skull region is displayed.

Figure 5.4: Axial slice

5.1.2 Sagittal orientation

The sagittal orientation consists of cuts made laterally in relation to the
region of interest, i.e. parallel cuts to the sagittal plane of the human body,
which divides it into the left and right portions. In Figure 5.5, a sagittal
skull image is displayed.

Figure 5.5: Sagittal slice
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5.1.3 Coronal orientation

The coronal orientation is composed of cuts parallel to the coronal plane,
which divides the human body into ventral and dorsal halves. In Figure 5.6
is displayed a skull image in coronal orientation.

Figure 5.6: Coronal slice

5.2 Correspondence between the axial, sagittal

and coronal orientations

To find out the common point of intersection of the images in differents
orientations, simply activate the "Slices cross intersection" feature with the
shortcut icon located on the toolbar. See Figure 5.7.

Figure 5.7: Shortcut to show common point between different orientations

When the feature is activated, two cross-sections that intersect perpen-
dicularly are displayed on each image (Figure 5.8). The intersection point
of each pair of segments represents the common point between differents
orientations.
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To modify the point, hold down the left mouse button and drag. Auto-
matically, the corresponding points will be updated in each image.

Figure 5.8: Common point between differents orientations

To deactivate the feature, simply click on the shortcut again (Figure 5.7).
This feature can be used in conjunction with the slice editor (which will be
discussed later).

5.3 Interpolation

By default the 2D images visualization are interpolated (Figure 5.10).a). To
deactivate this feature, select theViewmenu and select Interpolated slices
(Figure 5.9). It will then be possible to visualize each pixel individually as
shown in Figure 5.10.b.

This interpolation is for visualization purposes only, and does
not directly influence segmentation or 3D surface generation.
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Figure 5.9: Menu to disable and enable interpolation

(a) Interpolated (b) Non-interpolated

Figure 5.10: Interpolated and non-interpolated image visualization.

5.4 Move

To move an image on the screen, use the Move shortcut icon on the toolbar
(Figure 5.11). Click on the icon to activate, then with the left mouse button
on the image, drag it to the desired direction. Figure 5.12 shows a displaced
(moved) image.

Figure 5.11: Shortcut to move images
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Figure 5.12: Displaced image

5.5 Rotate

Images can be rotated by using the Rorate shortcut on the toolbar (Fig-
ure 5.13). To rotate an image, click on the icon and then with the left
mouse button drag clockwise or anticlockwise as required.

Figure 5.13: Shortcut to rotate images

Figure 5.14: Rotated image

46



5.6 Zoom

In InVesalius, there are different ways to enlarge an image. You can maximize
the desired orientation window, apply zoom directly to the image, or select
the region of the image to enlarge. Each of these methods are detailed below.

5.6.1 Maximizing orientation windows

The main InVesalius window is divided into 4 sub-windows: axial, sagittal,
coronal and 3D. Each of these can be maximized to occupy the entire area of
the main window. To do this, simply left mouse click on the subwindow icon
located in the upper right corner (Figure 5.15). To restore a maximized
window to its previous size, simply click the icon again.

Figure 5.15: Detail of a sub-window (Note the maximize icon in the upper
right corner)

5.6.2 Enlarging or shrinking an image

To enlarge or shrink an image, click on the zoom shortcut icon in the toolbar
(Figure 5.16). Hold down the left mouse button on the image and drag the
mouse up to enlarge or down to shrink.

Figure 5.16: Zoom shortcut
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5.6.3 Enlarging an image area

To enlarging a certain image area, click on the "Zoom based on selection"
icon in the toolbar (Figure 5.17). Position the mouse pointer at the origin
point of the selection, click and hold the left mouse button and drag it to
the end selection point to form a rectangle (Figure 5.18). Once the left mouse
button is released, the zoom operation will be applied to the selected region
(Figure 5.19).

Figure 5.17: Zoom based on selection shortcut

Figure 5.18: Area selected for zoom

5.7 Brightness and contrast (Windows)

To improve image visualization, the window width and window level features
can be used; these are more commonly known as brightness and contrast or
window (for radiologists). With this feature, it is possible to set the range of
the gray scale (window level) and the width of the scale (window width) to
be used to display the images.
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Figure 5.19: Enlarged Image

The feature can be activated by the "Brightness and Contrast" shortcut
icon in the toolbar. See Figure 5.20.

Figure 5.20: Brightness and contrast shortcut

To increase the brightness, hold down the left mouse button and drag
horizontally to the right. To decrease the brightness, simply drag the mouse
to the left. The contrast can be changed by dragging the mouse (with the
left button pressed) vertically: up to increase, or down to decrease contrast.

To deactivate the feature, click again on the shortcut icon (Figure 5.20).
Preset brightness and contrast patterns may be used with InVesalius.

Table 5.1 lists some tissue types with their respective brightness and contrast
values. To use the presets, position the mouse cursor over an image and
right-click to open a context menu, then select Window width and level,
and click on the preset option according to the tissue type, as shown in
Figure 5.21.
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Figure 5.21: Context menu for brightness and contrast selection

Table 5.1: Brightness and contrast values for some tissues

Tissue Brightness Contrast
Default Exam Exam
Manual Changed Changed
Abdomen 350 50
Bone 2000 300
Brain 80 40
Brain posterior fossa 120 40
Contour 255 127
Emphysema 500 -850
Ischemia - Hard, non contrast 15 32
Ischemia - Soft, non contrast 80 20
Larynx 180 80
Liver 2000 -500
Lung Hard 1000 -600
Lung Soft 1600 -600
Mediastinum 350 25
Pelvis 450 50
Sinus 4000 400
Vasculature - Hard 240 80
Vasculature - Soft 680 160
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(a) Bone (b) Lung

Figure 5.22: Different types of brightness and contrast

5.8 Pseudo color

Another feature to improve the visualization of the images is the pseudo
color. This replaces gray levels by color, or by inverted gray levels. In the
latter case, previously clear regions of the image become darker and vice
versa.

To change the view using a pseudo color, position the mouse cursor over
the image and right-click to open a context menu on it. When the menu
opens, select the entry Pseudo color, and then click on the desired pseudo
color option, as shown in Figure 5.23.

Figures 5.24a-g demonstrate the various pseudo color options available.
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Figure 5.23: Pseudo Color
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(a) Default (b) Inverted Gray Im-
age

(c) Rainbow

(d) Desert (e) Hue (f) Ocean

(g) Saturation

Figure 5.24: Some different types of pseudo-color

5.9 Projection type

It is possible to change the projection type of the 2D images, in addition to
the normal mode, InVesalius has six types of projections that can be accessed
as follows: Place the mouse over the image and rigth-click to open a context
menu on it. When the menu opens, select the projection type option, and
then click on the desired projection option, as shown in the Figure 5.31.
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Figure 5.25: Projection Type menu

5.9.1 Normal

Normal mode is the default view, showing the unmodified image as it was
when acquired or customized previously with either brightness and contrast
or pseudo color. Normal mode is shown below in Figure 5.32.

Figure 5.26: Normal projection

5.9.2 MaxIP

MaxIP is also known as MIP (Maximum Intensity Projection). MaxIP selects
only voxels that have maximum intensity among those visited as shown in
Figure 5.33. According to the amount of, or "depth" of MaxIP, each voxel
is visited in order of overlap, for example, to select MaxIP of the pixel (0, 0)
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consisting of 3 slices it is necessary to visit pixel (0, 0) of slices (1, 2, 3) and
select the highest value.

Figure 5.27: MaxIP projection

As shown in Figure 5.34, the number of MaxIP images is set at the bottom
of each orientation image.

Figure 5.28: Selection the amount of images that composes the MaxIP or
MIP

5.9.3 MinIP

Unlike MaxIP, MinIP (Minimum Intensity Projection) selects only the voxels
that have minimal intensity among those visited, as shown in Figure 5.35.
The image number selection comprising the projection is made at the bottom
of each orientation image as shown in Figure 5.34.

55



Figure 5.29: MinIP projection

5.9.4 MeanIP

The MeanIP (Mean Intensity Projection) technique which is shown in the
Figure 5.36 composes the projection by averaging voxels visited in the same
way as the MaxIP and MinIP methods. It is also possible to define how
many images will compose the projection at the bottom of the image of each
orientation as shown in Figure 5.34.

5.9.5 MIDA

The MIDA (Maximum Intensity Difference Accumulation) technique projects
an image taking into account only voxels that have local maximum values.
From each pixel a ray is simulated towards the volume, with each voxel being
intercepted by each ray reaching the end of the volume. Each of the voxels
visited has its accumulated value, but are taken into account only if the
value is greater than previously visited values. Like MaxIP, one can select
how many images are used to accumulate the values. Figure 5.37 shows an
example of MIDA projection.

As Figure 5.38 shows, it is possible to invert the order that the voxels are
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Figure 5.30: MeanIP projection

Figure 5.31: MIDA projection

visited by selecting the Inverted order option in the lower corner of the
screen.
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Figure 5.32: Inverted order MIDA projection

5.9.6 Contour MaxIP

The Contour MaxIP function consists of visualizing contours present in the
projection generated with MaxIP technique(5.9.2). An example is presented
in Figure 5.39.

5.9.7 Contour MIDA

The Contour MIDA function consists of visualizing contours present in the
projection generated with the MIDA technique(5.9.5). Like MIDA, you can
reverse the order that the volume is visited, as shown in Figure 5.40.
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Figure 5.33: Contour MaxIP projection

Figure 5.34: Contour MIDA projection
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Chapter 6

Segmentation

To select a certain type of tissue from an image it is used the segmentation
feature at InVesalius.

6.1 Threshold

When using the thresholding segmentation technique, only the pixels whose
intensity is inside the threshold range defined by the user are detected. The
threshold is defined by two values, the initial (minimum) and final (maxi-
mum) threshold.

In thresholding segmentation technique only the pixels whose intensity is
inside threshold range defined by the user. Threshold is defined by two num-
ber, the initial and final threshold, also known as minimum and maximum
threshold. ...

Thresholding segmentation is located the InVesalius left-panel, item 2.
Select region of interest (Figure 6.1).

Before starting a segment it is necessary to configure a mask. A mask
is a image over to examine an image where the selected regions are colored.
(Figure 6.2).

To change the threshold, use the image greyscale control (Figure 6.3).
Move the left sliding control to change the initial threshold. Move the right
sliding control to change the final threshold. It is also possible to to input
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Figure 6.1: Select region of interest - Threshold

Figure 6.2: Mask - selected region in yellow.

the desired threshold values in the text boxes in the left and right side of
the thresholding control. The mask will be automatically updated when
the thresholding values are changed, showing in color the pixels inside the
thresholding range.

Figure 6.3: Selecting pixels with intensity between 226 and 3021 (Bone)

It is also possible to select some predefined thresholding values based on
some type of tissues, like those displayed in Figure 6.4. Just select the desired
tissue and the mask will automatically update.

Table 6.1 show thresholding values according to some tissues or materials.
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Figure 6.4: Selection list with some predefined thresholding values.

Table 6.1: Predefined thresholding values to some materials

Material Initial threshold Final Threshold
Bone 226 3021
Compact Bone (Adult) 662 1988
Compact Bone (Child) 586 2198
Custom User Def. User Def.
Enamel (Adult) 1553 2850
Enamel (Child) 2042 3021
Fat Tissue (Adult) -205 -51
Fat Tissue (Child) -212 -72
Muscle Tissue (Adult) -5 135
Muscle Tissue (Child) -25 139
Skin Tissue (Adult) -718 -177
Skin Tissue (Child) -766 -202
Soft Tissue -700 225
Spongial Bone (Adult) 148 661
Spongial Bone (Child) 156 585

Table 6.1 indicates images obtained from medical tomographs. The range
of gray values from images obtained from odontological tomographs are
greater and non-regular. Thus, it is necessary to use sliding controls (Fig-
ure 6.3) to adjust the thresholding values.

To create a new mask, click Create new mask (Figure 6.5). Then, click
Select region of interest.

Figure 6.5: Button to create a new mask.

After clicking on this button a dialog will be shown (Figure 6.6). Select
the desired threshold and click on Ok.
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Figure 6.6: Creating a new mask.

After segmentation it is possible to generate a corresponding 3D surface.
The surface is formed by triangles. The following chapter will give more
details about surfaces.

Click on the Create surface button (Figure 6.7) to create a new surface.
If there is a surface created previously you may overwrite it with the new
one. To do this select the option Overwrite last surface before creating
the new surface.

Figure 6.7: Create surface button.

After a few moments the surface will be displayed at the 3D visualization
window of InVesalius (Figure 6.8).

Figure 6.8: 3D surface.
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6.2 Manual segmentation (Image edition)

Thresholding segmentation may not be efficient in some cases since it is
applied to the whole image. Manual segmentation may be used to segment
only an isolated region. Manual segmentation also allows users to add or
remove some image regions from the segmentation. To use it click onManual
edition (Figure 6.9) to open the manual segmentation panel.

Figure 6.9: Icon to open the Manual segmentation panel.

Figure 6.10 show the Manual segmentation panel.

Figure 6.10: Manual segmentation panel.

There are two brushes used for segmentation: a circle and a square. Click
on the triangle icon (see Figure 6.11) to show brush types, then click on the
desired brush.

Figure 6.11: Brush types.
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Brush sizes can also be adjusted, as shown in Figure 6.12.

Figure 6.12: Adjusting the brush size.

The following are available options when using brushes in InVesalius:

• Draw: for adding a non-selected region to the segmentation;

• Erase: for removal of a non-selected region;

• Threshold: applies the thresholding locally, adding or removing a
region inside or outside of the threshold range.

Figure 6.13 shows the available brush operations.

Figure 6.13: Brush operations

Figure 6.14 shows a image with noise caused by the presence of a dental
prosthesis. Note the rays emerging from the dental arch: the thresholding
segments the noise since its intensity is inside of the threshold of bone.

Figure 6.15 shows a surface created from that segmentation.
In such cases use the manual segmentation with the erase brush. Keep

the left mouse button pressed while dragging the brush over the region to
be removed (in mask).

Figure6.17 shows the image from Figure 6.14 after.
A surface can be generated after manual segmentation (Figure 6.18).

Since it was used in the manual segmentation procedure, when clicking on
Create surface button, a dialog (Figure 6.19) will be opened to to select if
the surface will be created with the method Binary (blocky) or Context
aware smoothing (smoother).
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Figure 6.14: Noisy image segmented with threshold.

Figure 6.15: Surface generated from noisy image.

6.3 Watershed

In watershed segmentation the user demarcates objects and background de-
tail. This method treats the image as watershed (hence the name) in which
the gray values (intensity) are the altitudes, forming valleys and mountains.
The markers are water source. The waters fill the watershed until the wa-
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Figure 6.16: Zoom in the noisy area.

Figure 6.17: After removing the noise.

Figure 6.18: Surface generate after removing the noise.

ters gather together, thus distinguishing background from object. To use
Watershed segmentation click on Watershed to open the watershed panel
(Figure 6.20).

Before segmenting to with Watershed it recommended to clean the mask
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Figure 6.19: Surface creation methods

Figure 6.20: Watershed segmentation panel.

(see section 7.2).
To insert a marker (object or background), a brush is used, similar to

manual segmenting. You can use a circle or square brush and set its size.
Select brush operations from the following:

• Object: to insert object markers;

• Background: to insert background markers (not object);

• Delete: to delete markers;

The option Overwrite mask is used when the user wants the result of
watershed segmentation to overwrite the existing segmentation. The option
Use WWWL is used to make watershed take into account the image with
the values of window width and window level (not the raw image) which may
result in better segmentation.
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Click on the button on the left side of the panel (Figure 6.21) to access
more watershed configurations. This button will open a dialog (Figure 6.22).
The method option allows to choose the Watershed algorithm to be used
to segment. It may be the conventional Watershed or Watershed IFT,
which is based on the IFT (Image Forest Transform) method. In some cases,
like brain segmentation, the Watershed IFT may have a better result.

The connectivity option refers to the pixel neighbourhood (4 or 8 when
in 2D, or 6, 18 or 26 when in 3D). Gaussian sigma is a parameter used in
the smoothing algorithm (the image is smoothed before the segmentation to
remove the noise and get better results). The greater this value the smoother
the smoother the image will be.

Figure 6.21: Button to open the Watershed configuration dialog.

Figure 6.22: Watershed configuration dialog.

Normally the Watershed is applied only in one slice, not in the whole
image. After adding the markers is possible to apply the watershed to the
whole image by clicking on the button Expand watershed to 3D. Fig-
ure 6.23 shows the result of watershed segmentation in a slice (2D) of brain
image.

Figure 6.24 shows the segmentation expanded to the whole image (3D).
Figure 6.23 also shows the object markers (in light green), the background

markers (in red) and the segmentation mask (in green) overlaying the selected
regions (result).
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Figure 6.23: Watershed applied to a slice.

Figure 6.24: Brain segmentation using the watershed method applied to the
whole image (3D).
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6.4 Region growing

Region growing tool is accessed in the menu Tools, Segmentation, Region
growing (figure 6.25). Before segmenting select if the operation will be in
2D - Actual slice or 3D - All slices. It is also necessary to select the
connectivity: 4 or 8 to 2D or 6, 18 or 26 to 3D. It’s also necessary to select the
method, which may beDynamic, Threshold, or Confidence (figure 6.26)

Figure 6.25: Menu to access the region growing segmentation segmentation
tool.

Figure 6.26: Dialog to configure the parameters of region growing segmenta-
tion tool.

This segmentation technique starts with a pixel (indicated by the user
left-clicking with the mouse). The selection expands by analyzing the neigh-
bourhood of the selected pixels and including those of a given set of qualities.
Each region growing method has a different condition of selection:
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• Dynamic: Uses the value of the pixel clicked by the user. Then every
connected pixel inside the lower (min) and the upper (max) range devi-
ation are selected. The option Use WWWL is default and takes into
account the image with window width and window level applied
not the raw one (figure 6.27).

Figure 6.27: Dynamic method parameters.

• Threshold: This method selects the pixels whose intensity are inside
the minimum and maximum threshold (Figure 6.28).

Figure 6.28: Adjust the threshold.

• Confidence: This method starts by calculating the standard deviation
and the mean value of the pixel selected by the user and its neighbour-
hood. Connected pixels with value inside the range (given by the mean
more and less the standard deviation multiplied by the Multiplier
parameter). It then calculates the mean and the standard deviation
from the selected pixels, then carries out the expansion. This process
is repeated according to the Iterations parameter. Figure 6.29 shows
the parameters for this method.
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Figure 6.29: Confidence parameter.
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Chapter 7

Mask

7.1 Boolean operations

After segmenting, some boolean operations can be performed between masks.
The boolean operations supported by InVesalius are:

• Union, perform union between two masks;

• Difference, perform difference from the first mask to the second one;

• Intersection, keeps what is common in both masks.

• Exclusive disjunction (XOR): keeps the regions of the first mask
which are not in the second mask and regions from the second mask
which are no in the first mask.

To use this tool go to the Tools, menu, select Mask, and then Boolean
operations as shown in Figure 7.1. Select the first mask, the operation to be
performed and the second mask as shown in Figure 7.2 then click OK.

Figure 7.3 shows some examples of utilization of boolean operations tool.

7.2 Mask cleaning

A mask can be cleaned, as shown in Figure 7.4. This is recommended before
inserting Watershed markers. This tool is located on the Tools menu. Select
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Figure 7.1: Menu to open boolean operations tool.

Figure 7.2: Boolean operations tool.

Mask, then Clean mask, or use the shortcut CTRL+SHIFT+A.

7.3 Fill holes manually

Segmentation may leave some unwanted holes. It’s recommended to fill them
because the surface generated from this mask may have some inconsistencies.
To do this access the menu Tools, Mask, Fill holes manually (figure 7.5).
A dialog window will be shown (figure 7.6) to configure the parameters.

It is possible to fill hole on a mask slice (2D - Actual slice) or on all
slices, selecting the option (3D - All slices). The connectivity may also be
configured: 4 or 8 for 2D and 6, 18 and 26 for 3D.

After configuring the desired parameters left-click on holes to fill them.
Figure 7.7.a shows a mask with some holes and other mask with the holes
filled (Figure 7.7.b). Click on the close button or close the dialog to deactivate
this tool.
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(a) Mask A (b) Mask B (c) Union (A ∪ B)

(d) Difference (A - B) (e) Intersection (A ∩ B) (f) Exclusive disjunction (A ⊕
B)

Figure 7.3: example of boolean operations.

Figure 7.4: Mask cleaning

7.4 Fill holes automatically

To open this tool go to the Tools menu, select Mask then Fill holes auto-
matically (Figure 7.8). This will open a dialog to configure the parameters.
This tool doesn’t require the user to click on holes he desire to fill. This tool
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Figure 7.5: Menu to access the tool to fill holes manually.

Figure 7.6: Dialog to configure the parameters of Fill holes manually tool.

(a) Holes (b) Holes filled

Figure 7.7: Example of mask with holes filled.

will fill the holes based on the max hole size parameter given in number
of voxels (Figure 7.9).

Holes can also be filled on a mask slice (2D - Actual slice) or on all
slices, selecting the option (3D - All slices. The connectivity will thus be
4 or 8 to 2D and 6, 18 and 26 to 3D. If 2D, the user must indicate in which

77



Figure 7.8: Menu to open the Fill holes automatically tool.

Figure 7.9: Dialog to configure the parameters used to fill the holes.

orientation window the holes will be filled.
After setting the parameters click Apply. If the result is not suitable set

another hole size value or connectivity. Click Close to close this tool.

7.5 Remove parts

After generating a surface, it is recommended to remove the unwanted dis-
connected parts from a mask. This way the surface generation will use less
RAM and make the process quicker. To remove any unwanted parts, go to
the Tools menu, select Mask and then Remove Parts (Figure 7.10). A
dialog will be shown to configure the selection parameters (Figure 7.11).

It’s possible to select disconnected parts only on a mask slice (2D -
Actual slice) or on all slices (3D - All slices); users may also configure
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the connectivity at the same time.

Figure 7.10: Menu to open the Remove parts tool.

Figure 7.11: Dialog to configure the parameters used in Remove parts.

After selecting the desired parameters click with the left-button of the
mouse on the region you want to remove. Figure 7.12 shows an example of
a mask before and after the removal of unused parts. Click Close to stop
using this tool.

7.6 Select parts

To open the Select parts tool, access the Tools menu, select Mask then
Select parts (Figure 7.13). A dialog will be shown to configure the the
name of the new mask and the connectivity (6, 18 or 26).

To select a region, left-click on a pixel; multiple regions can be selected.
The selected region(s) will be shown with a red mask. After selecting all the
wanted regions, click OK to create a new mask with the selected regions.
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(a) Input image (b) Remove the tomograph support

Figure 7.12: Example of region remove from a mask.

Figure 7.15.a shows a region selected in red. Figure 7.15.b shows the selected
region in a new mask.

Figure 7.13: Menu to open the Select parts tool.

Figure 7.14: Dialog to configure the parameters of Select parts tool.
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(a) Region selected in red (b) Final image with only the selected
region

Figure 7.15: Example of mask region selection.

7.7 Crop

The crop tool allows users to select and use a specific section of image of
interest. This may reduce the amount of information needed to be processed
when generating a surface. To open, access the Tool menu, then Mask and
Crop (Figure 7.16).

Figure 7.16: Menu open the Crop tool.

A box allowing for the selection of a specific area will then be displayed.
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Chapter 8

Surface (Triangle mesh)

InVesalius, generates 3D surfaces based on image segmentation. A surface is
generated using the marching cubes algorithm by transforming voxels from
the stacked and segmented images to polygons (triangles in this case).

The controls to configure a 3D surface are accessible on the left panel, un-
der 3. Configure 3D surface, Surface properties you have the controls
to configure a 3D surface (Figure 8.1).

Figure 8.1: 3D surface configuration.

8.1 Creating 3D surfaces

News surfaces can be created using an already segmented mask. To do so, on
the left panel under 3. Configure 3D surface, click on the button shown
in Figure 8.2.
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Figure 8.2: Button to create a 3D surface.

After clicking this button a dialog will be shown (Figure 8.3). This dialog
allows for the configuration of the 3D surface created, including setting the
quality of the surface, filling surface holes whilst keeping the largest connected
region of the surface intact.

Figure 8.3: 3D surface creation dialog.

The keep largest region option may be used, for instance, to remove the to-
mograph supports. Figure 8.4 displays a surface created with Keep largest
region and Fill holes activated, whereas Figure 8.5 displays the surface
create without activating that options. Note the tomograph support and the
holes.

The Surface creation method item has the following options: Binary,
Context aware smoothing and Default. Figure 8.6 shows an example of
surface created using each of these 3 methods.

The Binary method takes as input the segmentation mask which is bi-
nary, where selected regions have value 1 and non-selected have value 0. As it
is binary, the surface generated has a blocky aspect, mainly in high curvature
areas, appearing staircases.

Context aware smoothing starts generating the surface using Binary,
then uses another algorithm in order to smooth the surface to avoid staircase
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(a) Frente (b) Baixo

Figure 8.4: Surface created with the options Keep largest region and Fill
holes activated.

(a) Frente (b) Baixo

Figure 8.5: Surface created with the options Keep largest region and Fill
holes deactivated.

details. This method has 4 parameters presented below.
The angle parameter is the angle between 2 adjacent triangles. If the

calculated angle is greater than the angle parameter the triangle will be
considered a staircase triangle and will be smoothed. The angle parameter
ranges from 0 to 1, where 0 is 0◦ and 1 is 90◦. The Max distance is the
maximum distance that a non-staircase triangle may be from a staircase tri-
angle to be considered to be smoothed. Non-staircase triangles with distance
greater than Max distance also will be smoothed but the smoothing will be
determined by the Min. weight parameter. This parameter ranges from 0

(without smoothing) to 1 (total smoothing). The last parameter, N.steps,
is the number of times the smoothing algorithm will be run. The greater this
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parameter the smoother the surface will be.
TheDefaultmethod is enabled only when thresholding segmentation was

used without any manual modification to the mask. This method does not
use the mask image, but the raw image, and generates a smoother surface.

(a) Binary (b) Context aware (c) Default

Figure 8.6: Surface generated by each method.

8.2 Transparency

The Transparency function allows for the displaying of a surface transpar-
ently. To do so, select the desired surface from the list of surfaces, in the
item 3. Configure 3D surface, Surface properties (Figure 8.7).

Figure 8.7: Surface selection.

Then, to set the level of surface transparency, use the sliding control
shown in Figure 8.8; the more to the right, the more transparent the surface
will be.

Figure 8.8: Selection of surface transparency.
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Figure 8.9 shows 2 surfaces: the external surface in green has some level
of transparency which permits to see the internal surface in yellow.

Figure 8.9: Surface with transparency.
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8.3 Color

Surface colors can be altered by selecting the surface (Figure 8.7), and click-
ing on the colored button on the right of the surface selection list. Figure 8.10
displays this button, inside item 3. Configure 3D surface, Surface prop-
erties.

Figure 8.10: Button to change surface color.

A dialog will be shown (Figure 8.11). Select the desired color and click
on OK.

Figure 8.11: Color dialog.

8.4 Splitting disconnected surfaces

To split disconnected surfaces, select 3. Configure 3D surface, Advanced
options (Figure 8.12).

Figure 8.12: Advanced options.
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The advanced options panel will be displayed (Figure 8.13).

Figure 8.13: Advanced options panel.

8.4.1 Select largest surface

The option Select largest surface selects, automatically, only surface with
the greater volume. Click on the button illustrated in Figure 8.14. This
operation creates new a surface with only the largest surface.

Figure 8.14: Button to split the largest disconnected surface

As an example, the Figure 8.15 shows a surface before Select largest
surface.

Figure 8.15: Disconnected surfaces.

Whereas the Figure 8.16 shows the surface with largest disconnected re-
gion separated.
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Figure 8.16: Largest disconnected region separated.

8.4.2 Select regions of interest

Another selection option is Select regions of interest. To do this operation
click on the button illustrated in Figure 8.17, then click on the desired dis-
connected surface regions you want to select. Next click on Select regions
of interest. This operation will create a new surface with only the selected
disconnected regions.

Figure 8.17: Button to select the regions of interest.

As an example, the Figure 8.18 shows the surface created after the user
selects the cranium and the right part of the tomograph support.

Figure 8.18: Example of selected regions of interest
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8.4.3 Split all disconnected surfaces

Disconnected surface regions can also be split automatically. To do this, click
on the button illustrated in Figure8.19.

Figure 8.19: Button to split all the disconnected regions surface.

Figure 8.20 shows an example.

Figure 8.20: Example of split all disconnected regions surface.
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Chapter 9

Measures

InVesalius has linear and angular measurements in 2D (axial, coronal and
sagittal planes) and 3D (surfaces). It is thus possible to take measurements
of volume and area on surfaces.

9.1 Linear Measurement

To perform linear measurements, activate the feature by clicking on the short-
cut shown below, located on the toolbar (Figure9.1).

Figure 9.1: Shortcut to activate linear measurement

A linear measurement is taken between two points. With the feature
enabled, click once on the image to set the starting point. Then position the
mouse pointer on the end point and click once again. The measurement is
performed and the result is automatically displayed on the image or surface

Figure 9.2 shows a 2D linear measure in the axial orientation, and Fig-
ure 9.3 shows another linear measure in 3D (surface).

Once you have made a 2D linear measurement, it can be edited by placing
the mouse on one end, holding down the right mouse button and dragging
it to the desired position.
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Figure 9.2: Linear measure on image

Figure 9.3: Linear measure on surface

Note: The linear measurement is given in millimeters (mm).

9.2 Angular Measurement

An angular measurement in 2D on a surface (3D) can be done by clicking on
the shortcut shown in Figure 9.4.

Figure 9.4: Shortcut for angle measurement

To perform the angular measurement, it is necessary to provide the three
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points that will describe the angle to be measured, AB̂C. Insert the first point
by clicking once to select point A. Insert point B (the vertex or "point" of the
angle) by positioning the cursor and clicking once again. Repeat the same
actions to determine the endpoint of the angle, C. The resulting measurement
is displayed on the image or surface.

Figure 9.5 illustrates an angular measurement on a flat image; Figure 9.6
illustrates an angular measurement on a surface.

In regards to 2D linear measurement, you can also edit the 2D angular
measurement. Just position the mouse on one end, hold down the right
mouse button and drag it to the desired position.

Figure 9.5: Angular measurement

Figure 9.6: Angular measurement on surface

Note: Angular measurement is shown in degrees (◦)
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9.3 Volumetric Measurement

Volume and area measurements are made automatically when you create a
new surface. These are displayed in the Surfaces 3D tab in the Data man-
agement panel, located in the bottom left corner of the screen, as illustrated
in Figure 9.7.

Figure 9.7: Volumetric measurements

Note: Volume measurement is given in cubic millimeter (mm3),
already the one of area in square millimeter (mm2)
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Chapter 10

Data management

We have previously shown how to manipulate surfaces, masks for segmen-
tation and measurements. We can also show or hide, and create or remove
these elements in the Data management panel, located in the lower left cor-
ner of InVesalius. The panel is divided into 3 tabs: Masks, 3D Surfaces
and Measurements, as shown in Figure 10.1. Each tab contains features
corresponding to the elements it refers to.

Figure 10.1: Data management

In each tab, there is a panel divided into rows and columns. The first
column of each line determines the visualization status of the listed element.
The "eye" icon activates or deactivates the masks, surface or measurement
displayed. When one of these elements is being displayed, its corresponding
icon (as shown in Figure 10.2) will also be visible.
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Figure 10.2: Icon indicating the elements visibility

Some operations may be performed with the data. For instance, to remove
one element, first select its name, as shown in Figure 10.3. Next, click in the
shortcut shown in Figure 10.4.

Figure 10.3: Data selected

Figure 10.4: Remove data

To create a new mask, surface or measurement, click on the shortcut
shown in Figure 10.5, provided that the corresponding tab is open.

Figure 10.5: New data

To duplicate data, select data to be duplicated and click in the shortcut
shown in Figure 10.6.

Figure 10.6: Duplicate data

96



10.1 Masks

In the Name column, the mask’s color and name are shown. The Threshold
column shows the value range used to create the mask. Figure 10.1 shows
an example.

10.2 3D Surface

In the Name column, the surface’s color and name are shown. The Vol-
ume column shows the total surface volume. Finally, the Transparency
column indicates the level of transparency for use for surface visualization.
Figure 10.7 shows an example.

Figure 10.7: Surface manager

10.2.1 Import surface

We can also import STL, OBJ, PLY or VTP (VTK Polydata File Format)
files into an active InVesalius project. To do so, click in the icon shown in
Figure 10.8, select the format of the corresponding file, (Figure 10.9) and
click Open.

Figure 10.8: Shortcut to import surface
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Figure 10.9: Window to import surface

10.3 Measurements

The tab Measurements shows the following information. Name indicates
the color and measurement name. Local indicates where the measurement
was taken (image axial, coronal, sagital or 3D), and Type indicates the type
of measurement (linear or angular). Finally, Value shows the measurement
value. Figure 10.10 illustrates the Measurements tab.

Figure 10.10: Data management
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Chapter 11

Simultaneous viewing of images
and surfaces

Images and surfaces can be viewed simultaneously by left-clicking on the
shortcut (Figure 11.1) located in the lower right corner of the InVesalius
interface.

Figure 11.1: Shortcut for simultaneous viewing

This feature allows users to enable or disable the displaying of images
in different orientations (or plans) within the same display window of the
3D surface. Simply check or uncheck the corresponding option in the menu
shown in Figure 11.2.

Figure 11.2: Selection of the guidelines (plans) to display

It is worth noting that when a particular orientation is selected, a check
is presented in the corresponding option. This is illustrated in Figure 11.3.
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Figure 11.3: Selected Guidelines for display

If the surface is already displayed, the plans of the guidelines will be pre-
sented as shown in Figure 11.5. Otherwise, only the plans will be displayed.

Figure 11.4: Surface and plans displayed simultaneously
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Figure 11.5: Flat display (no surface)

To view the display of a plan, just uncheck the corresponding option in
the menu (Figure 11.3).
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Chapter 12

Volume Rendering

For volume rendering models, InVesalius employs a technique known as ray-
casting. Raycasting is a technique that simulates the trace of a beam of light
toward the object through each screen pixel. The pixel color is based on the
color and transparency of each voxel intercepted by the light beam.

InVesalius contains several pre-defined patterns (presets) to display spe-
cific tissue types or different types of exam (tomographic contrast, for exam-
ple).

To access this feature, simply click the shortcut shown in Figure 12.1 in
the lower right corner of the screen (next to the surfaces display window)
and select one of the available presets.

To turn off volume rendering, click again on the path indicated by Fig-
ure 12.1 and select the Disable option.

Figure 12.1: Shortcut to volume visualization

12.1 Viewing Standards

There are several predefined viewing patterns. Some examples are illustrated
in the following figures.
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Figure 12.2: Bright

Figure 12.3: Airway II
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Figure 12.4: Contrast Medium

Figure 12.5: MIP
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12.2 Standard Customization

Some patterns can be personalized (and customized). Figure 12.6 is exhibit-
ing a pattern and some graphical controls adjustment. With these features,
the color of a given structure and its opacity can be altered, determining if
and how it will be displayed.

Figure 12.6: Settings for the display pattern Soft Skin + II
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To hide a structure, use the control setting chart to decrease the opacity
of the corresponding region. In the example in Figure 12.6 suppose we want
to hide the muscular part (appearing in red). To do this, simply position the
pointer over the muscular part in red and, using the left mouse button, drag
the point down to reduce opacity and make the part transparent. Figure 12.7
illustrates the result.

Note: The Alpha value indicates the opacity of the color and the value,
the color intensity of the pixel.

Figure 12.7: Display Standard Soft Skin + II changed
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We can also remove or add points on the graph control setting. To remove,
simply click with the right mouse button on the point. To add a new point,
click the left button on the line graph. One can also save the resulting pattern
by clicking the shortcut shown in Figure 12.8.

Figure 12.8: Shortcut to save standard

To save the pattern, InVesalius displays a window like the one shown in
Figure 12.9. Enter a name for the custom pattern and click OK. The saved
pattern will be available for the next time the software is opened.

Figure 12.9: Window to save name of pattern.

12.3 Standard Customization with Brightness

and Contrast

You can customize a pattern without using the graphical control settings
presented in the previous section. This is done through the brightness and
contrast controls on the toolbar. Activate these by clicking the icon shown
in Figure 12.10.

Figure 12.10: Shortcut to Brightness and Contrast

Enable the control by dragging the mouse, with the left button pressed
on the volume window. This will change the values of the window width
and window level. The procedure is the same as with slices applied to 2D
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images, which can be seen in section 5.7. Dragging the mouse in a horizontal
direction changes the window level value; drag left to decrease and right to
increase. Dragging the mouse vertically changes the value of window width;
drag down to decrease and up to increase.

Manipulating these values can be useful for different viewing results. For
example, to add tissue to the display, drag the mouse diagonally with left
button pressed from the lower right to the upper left corner of the preview
window. To remove tissue visualization, do the opposite, (i.e drag the mouse
diagonally from top left to bottom right with the left button pressed.). See
Figure 12.11.

(a) Bone (b) Muscle (c) Skin

Figure 12.11: Tissue Addition
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12.4 Cut

In volume rendering, the cut function is used to view a cross-section of a
region. With a volume pattern selected, click Tools, and then click Cut
plane (Figure 12.12).

Figure 12.12: Enabling plan to cut

An outline for cutting appears next to the volume. To make the cut, hold
the left mouse button on the plane and drag the mouse. To rotate the plane,
hold the left mouse button pressed on its edge and move the mouse in the
desired direction as shown in Figure 12.13.

When finished using the function, click Tools and again click Cut plane
(Figure 12.13).
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Figure 12.13: Image with clipping plane
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Chapter 13

Stereoscopic Visualization

InVesalius supports stereoscopic visualization of 3D models. First a surface
(see chapter 8) or an active volumetric visualization (see chapter 12) must
be created. Then, click the icon (shown in Figure 13.1) on the bottom right
part of the interface and choose the desired projection type (Figure 13.2).

Figure 13.1: Shortcut to activate stereoscopic viewing methods.

Figure 13.2: Different methods of stereoscopic visualization.

InVesalius supports the following types of stereoscopic viewing:

• Red-blue

• Anaglyph

• CristalEyes
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• Interlaced

• Left

• Right

• Dresden

• Checkboard

Figure 13.3 presents three different types of projections.

(a) Interlaced (b) Anaglyph

(c) Red-blue

Figure 13.3: Example of different methods of stereoscopic applied on a sur-
face.
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Chapter 14

Data export

InVesalius can export data in different formats, such as OBJ, STL and others,
to be used in other software.

The menu to export data is located in the left panel of InVesalius, inside
item 4. Export data (displayed below in Figure 14.1). If the menu is not
visible, double-click with the left mouse button to expand the item.

Figure 14.1: Menu to export data

14.1 Surface

To export a surface, select it from the data menu as shown in Figure 14.2.
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Figure 14.2: Select surface to be exported

Next, click on the icon shown in Figure 14.3.

Figure 14.3: Shortcut to export surface

When the file window displays (as shown in Figure 14.4), type the file
name and select the desired exported format. Finally, click Save.

Figure 14.4: Window to export surface

Files formats avaiable for exportation are listed in table 14.1:
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Table 14.1: File formats exported by InVesalius

Format Extension
Inventor .iv
Polygon File Format .ply
Renderman .rib
Stereolithography (formato binário) .stl
Stereolithography (formato ASCII) .stl
VRML .vrml
VTK PolyData .vtp
Wavefront .obj

14.2 Image

Images exhibited in any orientation (axial, coronal, sagittal and 3D) can be
exported. To do so, left-click on the shortcut shown in Figure 14.5 and
select the sub-window related to the target image to be exported.

Figure 14.5: Menu to export images

On the window shown (Figure 14.6), select the desired file format, then
click Save.
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Figure 14.6: Window to export images
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Chapter 15

Customization

Some customization options are available for InVesalius users. They are
shown as follows.

15.1 Tools menu

To hide/show the side tools menu, click the button shown in Figure 15.1.

Figure 15.1: Shortcut to hide/show side tools menu

With the menu hidden, the image visualization area in InVesalius is ex-
panded, as shown in Figure 15.2.
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Figure 15.2: Side menu hidden

15.2 Automatic positioning of volume/surface

To automatically set the visualization position of a volume or surface, click
on the icon shown in Figure 15.3 (located in the inferior right corner of
InVesalius screen) and choose one of the available options for visualization.

Figure 15.3: Options for visualization positioning
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15.3 Background color of volume/surface win-

dow

To change the background color of the volume/surface window, click on the
shortcut shown in Figure 15.4. The shortcut is also located in the lower right
corner of the InVesalius screen.

Figure 15.4: Shortcut to background color of volume/surface window

A window for color selection opens (Figure 15.5). Next, simply click over
the desired color and then click OK.

Figure 15.5: Background color selection
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Figure 15.6 illustrates an InVesalius window with the background color
changed.

Figure 15.6: Background color modified
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15.4 Show/hide text in 2D windows

To show or hide text in 2D image windows, click on the shortcut illustrated
in Figure 15.7 on the toolbar.

Figure 15.7: Shorcut to show or hide texts

Figures 15.8 and 15.9 show text enabled and disabled, respectively.

Figure 15.8: Show texts enabled

Figure 15.9: Show texts disabled
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Chapter 16

Neuronavegation

An introduction to neuronavigation theory was presented in section 1.1.5.
Please read that section before using the features detailed below.

To enable the InVesalius neuronavigation mode, select the Mode tab in
the main menu and then Navigation (Figure 16.1). A Navigation System
tab will then display in the panel to the left of the main window, as shown
in Figure 16.2.

Figure 16.1: Menu to enable neuronavigation mode.

16.1 Spatial trackers and reference mode

Currently, InVesalius Navigator supports four spatial tracking devices from
two manufacturers: the MicronTracker from ClaroNav (Toronto, Canada;
Figure 16.3) and Fastrak, Isotrak and Patriot from Polhemus (Colchester,
United States; Figure 16.4).

First, choose the tracker in the menu Select tracker (Figure 16.5). The
option Debug tracker allows the user to test the system even if there is no
spatial tracker connected, instead simulating a spatial tracker by generating
random coordinates.
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Figure 16.2: Tab for navigation system.

Figure 16.3: ClaroNav MicronTracker - www.claronav.com/microntracker/.

Figure 16.4: Polhemus Patriot tracker - http://polhemus.com/motion-
tracking/overview/.

There are two methods to perform the navigation: static and dynamic
(Figure 16.6). Static mode uses just one spatial tracker probe. In this mode,
the subject’s head must stay motionless after registration (for more info about
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Figure 16.5: Menu to select tracking device.

coregistration see Section 16.2 probes: a reference probe must head (e.g.
forehead). during the probe will detect and correct any 16.2). Dynamic mode
uses multiple be attached to a static part of the neuronavigation process; the
reference movements from the head.

Figure 16.6: Menu to select reference mode.

16.2 Coregistration

The aim of coregistration is to transform a coordinate given in the track-
ing device space to a coordinate in the virtual space (image). To perform
coregistration, the user must use the function Correspondence between
orientations axial, sagittal and coronal (see section 5.2) and select three
anatomical fiducials in the image. Then, collect the same three fiducials with
the spatial tracker. The most common anatomical fiducials are the nasion
and both tragus (ears). Figure 16.7 shows the fiducials panel. When an image
fiducial is selected, a marker (green sphere) is created (shown in Figure 16.8).

Figure 16.7: Buttons and coordinates to select anatomical fiducials.

The buttons acronyms represent:
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• LEI: left ear in image

• REI: right ear in image

• NAI: nasion in image

• LET: left ear with spatial tracker

• RET: right ear with spatial tracker

• NAT: nasion with spatial tracker

Figure 16.8: Selected fiducial markers represented as green spheres.

16.3 Fiducial registration error and navigation

After all fiducials are selected in both spaces (tracker and image), press the
Navigate button to start the neuronavigation process. To stop navigation,
simply press Navigate again. Immediately after the navigation starts, the
Fiducial Registration Error (FRE) is calculated. The FRE is the root
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mean square distance between the image fiducials used before and after reg-
istration.

To the left of the Navigate button there is a FRE text box. If FRE is
high (greater than 3 mm) the navigation will not be precise and the text box
will become red (Figure 16.9). If this occurs, the coregistration should be
redone. If FRE is lower than 3 mm, the text box will turn green, showing
that the navigation has an acceptable precision (Figure 16.10).

Figure 16.9: Navigation button and high FRE unsuitable for navigation.

Figure 16.10: Navigation button and low FRE suitable for navigation.

16.4 Markers

During navigation, it is possible to create sphere markers in the 3D space.
To do so, select the Extra tools tools tab (Figure 16.11).

Figure 16.11: Markers manipulation tab.

The marker will be positioned in the current red cross position. The size
and color can be changed as needed (Figure 16.12).
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When a marker is created, its coordinates will appear in the list control.
To identify one marker in the volume, double-click with the left mouse
button on the target item and the corresponding marker will blink. To stop
blinking, select another marker. It is also possible to create an ID for the
marker; simply right click and select Edit ID (Figure 16.13). Finally, a
window will open allowing the user to define the ID (Figure 16.14).

Figure 16.12: Volume with different colors markers.

Figure 16.13: Task to manage marker creation.

The marker coordinates may be exported using the Save button (the file
extension will be .mks). This extension can be opened in any word processor,
e.g. Notepad or WordPad software. The file will contain the X, Y and Z
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Figure 16.14: Window to label the marker.

coordinates followed by the RGB code, marker size and ID. Afterwards, the
markers can be imported into the navigation system using the Load button.

To remove markers, select one or more markers needing deletion and
press Remove. It is also possible to remove all markers, with the button
Remove all markers. All markers can be hidden or shown in the volume
using the show/hide button.

16.5 External trigger checkbox

Markers can also be created by using an external trigger. To activate this
feature, press the checkbox External trigger before starting navigation.
This function was developed to communicate with TMS devices by creating a
marker where the pulses are applied, and can be adapted as the user requires.
Communication with an external device requires serial port COM1. If this
port receives any RS-232 signal at a 9600 baud rate it will create a marker
in the current red cross position.

16.6 Camera volume checkbox

The volume camera positioning is updated automatically, both by the red
cross and the spatial tracker probe position. The user can disable this func-
tion by unchecking the Camera volume checkbox. However, the camera
has to be manually changed.
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